## Preface, Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Documentation</td>
<td>1</td>
</tr>
<tr>
<td>PCS 7 OS Web Option V6.1 Release Notes</td>
<td>2</td>
</tr>
<tr>
<td>Function Overview</td>
<td>3</td>
</tr>
<tr>
<td>Hard and Software Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Licensing for the OS Web Server and OS Web Client</td>
<td>5</td>
</tr>
<tr>
<td>Installation of the OS Web server</td>
<td>6</td>
</tr>
<tr>
<td>Configuration of the OS Web Server on the ES</td>
<td>7</td>
</tr>
<tr>
<td>Completing the Configuration on the OS Web server</td>
<td>8</td>
</tr>
<tr>
<td>Installations and Settings for the OS Web Client</td>
<td>9</td>
</tr>
<tr>
<td>Status Information</td>
<td>10</td>
</tr>
<tr>
<td>Appendix</td>
<td>A</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
</tbody>
</table>

## Preface, Contents
Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The notices shown below are graded according to the degree of danger.

**Danger**
indicates that death or severe personal injury **will** result if proper precautions are not taken.

**Warning**
indicates that death or severe personal injury **may** result if proper precautions are not taken.

**Caution**
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not taken.

**Caution**
without a safety alert symbol indicates that property damage can result if proper precautions are not taken.

**Attention**
indicates that an unintended result or situation can occur if the corresponding notice is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by **qualified personnel**. Within the context of the safety notices in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

**Warning**
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG.
The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Copyright Siemens AG 2005 All rights reserved

The distribution and duplication of this document or the utilization and transmission of its contents are not permitted without express written permission. Offenders will be liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved.

Siemens AG
Automation and Drives
Postfach 4848, 90327 Nuremberg, Germany

Siemens Aktiengesellschaft

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG 2005
Technical data subject to change.

A5E00352763-01
Preface

Purpose of the PCS 7 Web Option Manual

This manual provides information about the software components, areas of application, design possibilities and commissioning of the OS Web Option for SIMATIC PCS 7.

The following basic question are addressed:

- What is the PCS 7 Web Option?
- Which software components belong to the OS Web Option for SIMATIC PCS 7?
- What are the hardware, software and licensing requirements for the installation?
- What are the areas of application for the OS Web Option for SIMATIC PCS 7?
- How can the PCS 7 OS Web Option be used in SIMATIC PCS 7?
- How is PCS 7 OS Web Option commissioned?

The electronic form of the "PCS 7 OS Web Option" manual is available on the DVD "Process Control System PCS 7 - Electronic Manuals". You can read and print it using the Acrobat Reader.

The "PCS 7 Web Option" electronic manual can be called up with the Windows command Start > SIMATIC > Documentation > English > PCS 7 OS Web Option.

The online help can be called up with the Windows command Start > SIMATIC > Documentation > English > PCS 7 - Basic Documentation > PCS 7 OS Web Option or directly with the SIMATIC Manager menu command Help > Help Topics > PCS 7 OS Web Option.

Required Knowledge

This configuration manual is intended for personnel involved in configuring, commissioning, servicing and operating automated systems with SIMATIC PCS 7.

The manual requires the reader to have basic knowledge about the PC/programming device and Windows. You should also be familiar with the functions and configurations of SIMATIC PCS 7.

Scope of Validity

The PCS 7 OS Web Option manual applies to the software package, SIMATIC PCS 7 V6.1.
Further Support

If you have any technical questions, please get in touch with your Siemens representative or agent responsible.
You will find your contact person at:

http://www.siemens.com/automation/partner

You will find a guide to the technical documentation offered for the individual SIMATIC Products and Systems here at:

http://www.siemens.com/simatic-tech-doku-portal

The online catalog and order system is found under:

http://mall.ad.siemens.com/

Training Centers

Siemens offers a number of training courses to familiarize you with the SIMATIC S7 automation system. Please contact your regional training center or our central training center in D 90327 Nuremberg, Germany for details:

Telephone: +49 (911) 895-3200.
Internet: http://www.sitrain.com
Technical Support

You can reach the Technical Support for all A&D products

- Via the Web formula for the Support Request
  
  http://www.siemens.com/automation/support-request

- Phone:  + 49 180 5050 222
- Fax:  + 49 180 5050 223

Additional information about our Technical Support can be found on the Internet pages http://www.siemens.com/automation/service

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Automation & Drives.
- Information on field service, repairs, spare parts and more under "Services".
# Contents

1. Additional Documentation .......................................................... 1-1
2. PCS 7 OS Web Option V6.1 Release Notes ................................. 2-1
3. Function Overview ..................................................................... 3-1
4. Hard and Software Requirements ............................................. 4-1
   4.1 Hardware and Software Requirements for the OS Web Server .... 4-1
   4.2 Hardware and Software Requirements for the OS Web Client .... 4-2
5. Licensing for the OS Web Server and OS Web Client .................. 5-1
6. Installation of the OS Web server ............................................. 6-1
7. Configuration of the OS Web Server on the ES .......................... 7-1
   7.1 Introduction .......................................................................... 7-1
   7.2 Web View Publisher .............................................................. 7-2
   7.2.1 Overview of Changes Performed by the Web View Publisher ... 7-2
   7.2.2 Web-capable Functions for PCS 7 OS Web Option .................. 7-2
   7.2.3 Requirements for Publishing .............................................. 7-3
   7.2.4 Overview of Procedures .................................................... 7-4
   7.2.5 How to Publish Local Data .................................................. 7-5
   7.2.6 How to Publish Project-specific Data from OS Servers .......... 7-9
   7.3 Setting User Rights ............................................................... 7-13
   7.3.1 Overview .......................................................................... 7-13
   7.3.2 How to Set User Rights in the User Administrator ................ 7-13
   7.4 Deactivating the Graphics Runtime ........................................ 7-15
   7.5 Downloading the OS Client (OS Web Server) ............................ 7-16
8. Completing the Configuration on the OS Web server .................... 8-1
   8.1 Checking the Settings ............................................................ 8-1
   8.2 Web Configurator ................................................................. 8-2
   8.2.1 Overview .......................................................................... 8-2
   8.2.2 Wizard-guided Web Setup: Web Configurator ...................... 8-2
   8.2.3 How to Set the Default Web Page for the OS Web Clients ....... 8-3
   8.2.4 Setting the Default Web Page for the OS Web Clients ............ 8-4
   8.2.5 Configuration in the Web Configurator for an Existing Web Site ... 8-5
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 Installations and Settings for the OS Web Client</td>
<td>9-1</td>
</tr>
<tr>
<td>9.1 Overview</td>
<td>9-1</td>
</tr>
<tr>
<td>9.2 How to Make the Settings in the Internet Explorer</td>
<td>9-2</td>
</tr>
<tr>
<td>9.3 How to Install the OS Web Client on Your PC</td>
<td>9-3</td>
</tr>
<tr>
<td>9.4 How to Install Plug-ins</td>
<td>9-5</td>
</tr>
<tr>
<td>9.5 How to Start Process Management on the OS Web Client</td>
<td>9-7</td>
</tr>
<tr>
<td>9.6 How to Set the Language for the Navigation Bar on the OS Web Client</td>
<td>9-8</td>
</tr>
<tr>
<td>9.7 Removal and Retro-installation / Updates Including Plug-ins on the OS Web Client</td>
<td>9-9</td>
</tr>
<tr>
<td>9.8 Functions of the OS Web Client in Process Mode</td>
<td>9-10</td>
</tr>
<tr>
<td>9.8.1 Overview</td>
<td>9-10</td>
</tr>
<tr>
<td>9.8.2 Supported Functions</td>
<td>9-10</td>
</tr>
<tr>
<td>10 Status Information</td>
<td>10-1</td>
</tr>
<tr>
<td>10.1 Status Information about the OS Web Server and OS Web Clients</td>
<td>10-1</td>
</tr>
<tr>
<td>10.2 How to Display Status Information</td>
<td>10-2</td>
</tr>
<tr>
<td>A Appendix</td>
<td>A-1</td>
</tr>
<tr>
<td>A.1 Supported Functions &quot;BPC&quot; und &quot;APC&quot;</td>
<td>A-1</td>
</tr>
<tr>
<td>A.2 Supported Functions &quot;SIMATIC BATCH WinCC Options&quot;</td>
<td>A-5</td>
</tr>
</tbody>
</table>

**Index**
# Additional Documentation

The following table lists documentation that provides additional information. The entire content of the online help (CHM) is also available in the electronic manuals (PDF).

<table>
<thead>
<tr>
<th>Online Help / Manual</th>
<th>Purpose</th>
<th>Following installation of SIMATIC PCS 7 V6.1, can be opened via:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Help: Web Navigator Information System Manual WinCC / Web Navigator</td>
<td>As WinCC product information, the documentation provides comprehensive information about installing and configuring the WinCC Web Navigator server and client.</td>
<td>Online Help: Start &gt; Simatic &gt; WinCC &gt; Web Navigator &gt; Web Navigator Information System Manual In the open &quot;Web Navigator Information System&quot; online help from the menu bar under Options &gt; Open PDF Note The online help and manual can only be called up from an OS Web server.</td>
</tr>
<tr>
<td>Manual PCS 7 – Programming Instructions for Blocks</td>
<td>The programming instructions describes how to create AS blocks or faceplates conforming to PCS 7.</td>
<td>Manual Can only be called up on an engineering station (ES) with the menu command Start &gt; Simatic &gt; Documentation &gt; English &gt; PCS 7 - Programming Instructions for Blocks</td>
</tr>
<tr>
<td>Online Help: Configuration - Operator Station Manual: PCS 7 - Configuration Manual Operator Station</td>
<td>The documentation provides support for project engineering using the SIMATIC PCS 7 process control system on an operator station.</td>
<td>Online Help: Start &gt; Simatic &gt; Documentation &gt; English &gt; PCS 7 - Basic Documentation &gt; Configuration - Operator Station Manual Start &gt; Simatic &gt; Documentation &gt; PCS 7 - Configuration Manual Operator Station</td>
</tr>
</tbody>
</table>
Online Help / Manual | Purpose | Following installation of SIMATIC PCS 7 V6.1, can be opened via:
--- | --- | ---
Online Help: Configuration - Engineering System Manual  
PCS 7 - Configuration Manual; Engineering System  
Online Help: Operator Station Process Management Manual  
PCS 7 - Operating Instructions Operator Station Process Management | The documentation provides support for project engineering using the SIMATIC PCS 7 process control system on an engineering station.  
The documentation provides detailed instructions with all the required information for safe operation and monitoring of processes using the SIMATIC PCS 7 process control system. | Online Help:  
Start > Simatic >  
Documentation > English >  
PCS 7 - Basic Documentation > Configuration - Engineering System  
Manual  
Start > Simatic >  
Documentation > PCS 7 - Configuration Manual; Engineering System  
Online Help:  
Start > Simatic >  
Documentation > English >  
PCS 7 - Basic Documentation > Operator Station Process Management Manual  
Start > Simatic >  
Documentation > PCS 7 - Operating Instructions Operator Station Process Management
2 PCS 7 OS Web Option V6.1 Release Notes

1: Installation of the Software

Hyperthreading: Hyperthreading must be disabled in the BIOS of the computer acting as an external OS Web server.

Multiprocessor systems: The external OS Web server is only approved for single-processor systems.

2: MS Security Patch for Dedicated Web Servers

Sporadic errors may occur under Windows 2000 or XP with external OS Web servers and redundant OS servers. These errors can be corrected by installing the MS Security Patch KB828741. This MS Security Patch can be installed from the PCS 7 Toolset DVD located in the “Microsoft” folder.

3: OS Web Client Setup

Before installing a newer version to the OS Web client through a download, you should check the languages installed on the OS Web client and the connected OS Web server. This is especially important when you switch between the “European” and “Asia” language regions. For example, if an OS Web client on which European languages are installed is connected to an OS Web server with Asian languages and a newer version is installed, the download on the OS Web client, only the languages of the OS Web server will be available on the OS Web client computer.

When installing the OS Web client through a download from the Intranet/Internet, you can choose to “Open” or “Save” the setup file. The method you use for the initial installation of the OS Web client must also be used for subsequent installations of plug-ins; otherwise you will get error message “Error 1316” from the “MSI Installer” service. This error message does not occur when you combine the installation methods “From DVD” and “Download with save.”
4: Windows XP on the Web Client

When using the OS Web client with Windows XP, Windows XP Service Pack 1 or later should be installed or else errors may occur when saving.

It is recommended to set the "Check for newer versions of stored pages" option under "Internet Options > Temporary Internet Files > Settings to "Automatic" in the Internet Explorer of the OS Web clients. Display errors may occur on the OS Web client when "Every visit to the page" is set. We also recommend this setting for OS Web clients under Windows 2000.

5: Restarting the Web Client after Changing the Licenses

When you change the licenses on the OS Web server, for example, to enable a greater number of clients, the Internet Explorer must be restarted on each connected OS Web client and the OS Web client must be logged on again. If you fail to do this, the OS Web client goes into Demo mode. This also applies to automatic connection (reconnect) of the OS Web client.

6: Performance of your OS Web Server

The speed and bandwidth of the Internet access on your OS Web server has a considerable effect on the performance of your PCS 7 projects and selection of pictures and refresh times of your OS Web clients. Each OS Web client requires a bandwidth of approximately 10 Kbps.

You can achieve maximum performance by operating your OS Web server an a LAN. If you connect your OS Web server to a 64K modem, however, you will have considerably less bandwidth and performance and thereby negatively influence the time it takes to load pictures, the refresh times and the number of OS Web clients that can be operated simultaneously.

7: Performance of External OS Web Servers

Tag logging: The number of trend values that can be supplied by an external OS Web server to the Online Trend Control on the OS Web clients, depends on the hardware used.

Typical values for system with Pentium 4, 2.4 GHz and 100 Mbit LAN:

The external OS Web server can supply 100 trend values in the 1s cycle per OS server:

- Example: 1 OS server: 50 OS Web clients can simultaneously display 2 trends in the 1s cycle, 20 trends in the 10s cycle; 25 OS Web clients can display 4 trends in the 1s cycle.

The external OS Web server can simultaneously supply 400 trend values to its OS Web clients:

- Example: With 4 OS servers that can each supply 100 trend values, 50 OS Web clients can simultaneously display 8 trends in the 1s cycle, 160 trends in the 10s cycle: 25 OS Web clients can display 16 trends in the 1s cycle.
• **Example:** With 10 OS servers that can each supply 40 trend values, 50 OS Web clients can simultaneously display 8 trends in the 1s cycle, 160 trends in the 10s cycle: 25 OS Web clients can display 16 trends in the 1s cycle. When a more powerful computer is used, the number of trend values that can be displayed simultaneously increases; the number of trend values per OS server, however, remains the same at approximately 100 trend values with 1s cycle time.

**Alarm Logging:**

The alarm server processes the requests of the controls sequentially. When numerous controls are simultaneously reported on an OS server, it may take some time before the last alarm control can display its alarms.

### 8: Restrictions with the PCS 7 OS Web Option

The restrictions are as follows:

- Operation with the hotkeys configured in WinCC is not supported on the OS Web client because the Internet Explorer cannot distinguish between the operator control objects from WinCC and its own.

- Synchronous script functions place a very heavy load on the system. The “SetTagxxx” function should be especially avoided in cyclic scripts. If numerous OS Web clients (>10) call SetTagxxx functions in a fast cycle (1s or shorter), the OS Web server becomes overloaded.

- Automatic logoff of a user: Automatic logoff after a specified time can be configured for each user in the User Administrator. This function is not supported by the OS Web client.
### Function Overview

The PCS 7 OS Web Option product enables you to operate and monitor automated processes via Intranet and Internet. You can use this solution beginning with SIMATIC PCS 7 V6.1.

The OS Web Option for SIMATIC PCS 7 consists of two components, the PCS 7 OS Web server and the PCS 7 and the OS Web client.

The PCS 7 OS Web server is an OS client within SIMATIC PCS 7 on which the PCS 7 OS Web server is additionally installed and configured. An OS client that has been expanded to a PCS 7 OS Web server can no longer be used as an OS client in the PCS 7 system. It must be used exclusively as a PCS 7 OS Web server. A Microsoft server operating system must be installed on the OS client used as a PCS 7 OS Web server. The PCS 7 OS Web server extension must be manually implemented based on the instructions provided by this documentation.

A PCS 7 OS Web client accesses the project data provided on the PCS 7 OS Web server via the Intranet or Internet using the Internet Explorer and enables you to operate and monitor processes.

The following terms are used in the documentation:

<table>
<thead>
<tr>
<th>Term</th>
<th>Synonym in the Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCS 7 OS Web server</td>
<td>OS Web server</td>
</tr>
<tr>
<td>PCS 7 OS Web client</td>
<td>OS Web client</td>
</tr>
</tbody>
</table>
The following figure represents the PCS 7 plant configuration with the OS Web Option.

The following legends for the figure above provides an overview for planning the configuration of the PCS 7 Web Option.

<table>
<thead>
<tr>
<th>Number</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| 1 | The following steps are performed in the OS Web server project on the ES:  
1st Publishing pictures in the Web View Publisher  
2nd Configuration of user rights and the home page for accessing the OS Web clients in the User Administrator.  
3rd Deactivation of the Graphics Runtime in the computer properties  
4th Downloading the OS client to be used as the OS Web server |
| 2 | The following steps are performed on the OS Web server:  
1st Check of the settings in the User Administrator after the download to the OS client (OS Web server)  
2nd Check if Graphics Runtime is deactivated in the computer properties  
3rd Start of Web Configurator |
**Function Overview**

**OS Web server**

The OS Web server is an OS client that stores all pictures to be displayed and required scripts to be executed on the OS Web client. All pictures and scripts must be correspondingly prepared. The “Web View Publisher” is used for this purpose.

---

**Note**

The OS Web server should not be used as an operator station (OS client) since it cannot guarantee the required reaction and response times.

---

The OS Web server manages the licenses (for PCS 7 and the Web Option): each OS Web client requires a license as soon as it accesses the OS Web server. The maximal permitted number of accessing OS Web clients corresponds to the number of licenses on the OS Web server. When the number of licenses is exhausted, no additional OS Web clients can access the OS Web server. Based on the license installed on the OS Web server, up to 50 OS Web clients can simultaneously access an OS Web server.

**OS Web Client**

The OS Web client requires the Windows operating system and the Internet Explorer. The components (plug-ins) required for operating the OS Web client must also be installed via the Intranet/Internet. The operator can then log onto the OS Web client and access the data of the OS Web server via a TCP/IP connection. The operating interface displayed in the Internet Explorer corresponds to that seen on OS clients with an overview, work area and keypad. All operation performed on the OS Web client are automatically logged with the name of the operator.
4 Hard and Software Requirements

4.1 Hardware and Software Requirements for the OS Web Server

The following hardware and software must be available on the OS Web server:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Windows 2003 Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Internet Explorer V6.0 SP1 or later, Internet Information Services (IIS)</td>
</tr>
<tr>
<td>Minimum requirements for the hardware (PC)</td>
<td>Intel Pentium IV, 2 GHz, 1024 MB free memory, network ports</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Access to Intranet/Internet or TCP/IP connection to OS Web client</td>
</tr>
</tbody>
</table>
4.2 Hardware and Software Requirements for the OS Web Client

The following hardware and software must be available on the OS Web client:

<table>
<thead>
<tr>
<th>Operating systems</th>
<th>Windows 2000 Professional; Service Pack 3 or 4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 2000 Server; Service Pack 3 or 4</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server</td>
</tr>
<tr>
<td></td>
<td>Windows XP Home; Service Pack 1 or 2</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional; Service Pack 1 or 2</td>
</tr>
<tr>
<td>Software</td>
<td>Internet Explorer V6.0 SP1 or later</td>
</tr>
<tr>
<td>Minimum requirements for the hardware (PC)</td>
<td>No PDAs, Table PCs, etc.</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>Access to Intranet/Internet or TCP/IP connection to OS Web server</td>
</tr>
</tbody>
</table>
5 Licensing for the OS Web Server and OS Web Client

OS Web server

The OS Web server will operate without a license in Demo mode for a period of 30 days.

License keys are required to unlock the OS Web server software package. There are license keys for 3 / 10 / 25 / 50 OS Web clients that can simultaneously access the OS Web server.

When the number of clients attempting to access the OS Web server exceeds the number licensed OS Web clients, a message appears informing the user that no additional OS Web clients can log on to the OS Web server.

OS Web Client

No OS Web server license is required for the PC on which the OS Web client runs.
Installation of the OS Web server

One of the two program packages, "OS Web Server including BATCH Faceplate" or "OS Web Server" can be selected in the PCS 7 system setup on the DVD.

To install the OS Web server, select in the "Package Installation" in the "Installation Type" setup dialog and activate "OS Web Server" under "Web Server" in the "Program Package" dialog.

On which PC is the OS Web server installed?

The OS Web server can only be installed on an OS client with the Windows Server 2003 operating system that is integrated in the terminal bus of the overall PCS 7 network. This OS client is then used exclusively as the OS Web server. The requirements listed under "Hardware and Software Requirements for the OS Web Client" must be fulfilled.

The components for the configuration of the PCS 7 OS Web Option on the ES are included in the "PCS 7 ES" package installation.

Following Installation

Following the installation of the OS Web server on an OS client, a new editor with the "Web Navigator" icon is added to the navigation window of the WinCC Explorer on the active OS. The additional "Web Navigator" editor offers a context menu that includes all required applications for configuring the OS Web server. Under Start > Simatic > WinCC > Web Navigator, you will also find the online help and applications for editing pictures to be displayed on the "Web PDL Publishing Wizard" PdlPad.

Additional Information

Configuring the OS Web Server
Installation of the OS Web server
7 Configuration of the OS Web Server on the ES

7.1 Introduction

The following OS Web server configurations are performed on the ES and can be selected in the context menu of the “Web Navigator” editor in the WinCC Explorer:

- The “Web View Publisher” adapts the project data (compresses the pictures, etc.) as required so that they are available via the Intranet/Internet on the OS Web client.
- Once you have downloaded the client project from the ES to the OS client (OS Web server), you can use the “Web Configurator” to configure the Web page for OS Web client access.

Note
To maintain consistency, you are not permitted to perform configuration locally on the PCS 7 OS Web server.

Notes on Configuring the OS Web Server

- OS Project Editor, layout: SIMATIC standard with all screen resolutions
- Configure trend groups in process pictures
- Use direct tag addressing

Further Information

Overview of Changes Performed by the Web View Publisher
Configuration Web Configurator
7.2 Web View Publisher

7.2.1 Overview of Changes Performed by the Web View Publisher

The Web View Publisher publishes all pictures and scripts displayed or executed on the OS Web client to the OS Web server. The following actions are performed here:

- Data is compressed and saved.
- If image windows are configured in process pictures, they are converted to Internet-compatible ActiveX components.
- All scripts are converted to make them compatible to the Web.

7.2.2 Web-capable Functions for PCS 7 OS Web Option

The PCS 7 OS Web Option does not support all standard script functions. Lists of web-capable standard script functions for the OS Web client are available in the following chapters or documentation:

- In the following chapters of this documentation:
  - Supported Functions
  - Supported Functions "BPC“ and APC”
  - Supported Functions "SIMATIC BATCH WinCC Options"
- In the following chapters of the "Web Navigator Information System“ online help, which can only be called up on an OS Web Server with the menu command Start > Simatic > WinCC > Web Navigator > Web Navigator Information System:
  - Appendix > C: Supported Functions
  - Appendix > D: Non-Supported Functions
- In section 2.1.9.6, Function Names in WinCC / Web, of the "PCS 7 - Programming Instructions for Blocks“ manual, which can only be called up on Engineering Station (ES) with the menu command Start > Simatic > Documentation > English > PCS 7 - Programming Instructions for Blocks.
7.2.3 Requirements for Publishing

The following requirements for publishing local and project-specific data must be fulfilled before you can work with the data with the Web View Publisher on the ES:

- A PCS 7 project has been created and fully configured.
- The "Compile OS" function has been executed for all OS servers so that the server data is available for all OS servers.
- An OS client has been inserted and configured into your PCS 7 project as a PC station to function as an OS Web server. The design of a PCS 7 project structure is described in the "Engineering Station Configuration Manual".
- All OS servers you wish to access from the OS Web clients must be assigned to the OS Web server. This loads the appropriate server data of the OS servers. Follow the procedure as described in the section "Downloading a Project and Configuring Changes > Meaning of the Server Data > How to Download Server Data" in the "Operator Station Configuration Manual".
- The C and VB scripts of all OS servers to which the OS Web clients should have access must be available on the OS Web server. The supported functions are listed in appendices C and D of the "Web Navigator Information System" online help.
- The names of the process pictures to be used by the OS Web clients should not contain two underscore characters (xx__xx.pdl). The string in front of the two underscores would otherwise be interpreted as the separator of the server prefix.
- Custom C standard functions cannot be published. If you wish to make these functions available on the OS Web clients, they must be saved as project functions and then published. The include command cannot be used in the project functions.
- The "@PTN_xx.pdl" pictures are specific to the OS Web server and must be published by each OS Web server with the corresponding server prefix.
- If tag names are specified in plain text (quotation marks) in C scripts, you cannot use spaces.
7.2.4 Overview of Procedures

1+ n publishing tasks are required on the ES. n is the number of OS servers (server pairs with redundancy) which the OS client (OS Web server) can access or whose pictures should be published.

The first publishing task involves local @ pictures and functions on the OS client (OS Web server). The other publishing tasks involve the pictures of the OS server.

The following standard procedure is generally used for publishing:

- Open the Web server project on the ES; the source path and destination path are on the ES during the configuration phase.

- Publish all the pictures of the WinCC source project on the ES (1 + n tasks, see above) and then load the PLC in the PC station of the OS Web server (OS client).
7.2.5 How to Publish Local Data

Procedure

<table>
<thead>
<tr>
<th>WinCC Publishing – Wizard Dialog</th>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Open the OS client you wish to use as the OS Web server in the WinCC Explorer on the ES. In the SIMATIC Manager (Component view) under: <strong>Project Name &gt; PC Station Name &gt; WinCC Application &gt; OS Web Server Name</strong>.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>In the navigation window of the WinCC Explorer, open the context menu of the &quot;Web Navigator&quot; object and select the menu command &quot;Web View Publisher&quot;. The &quot;WinCC Web Publishing Wizard – Introduction&quot; window opens.</td>
</tr>
<tr>
<td>Introduction</td>
<td>3</td>
<td>Click the &quot;Next &gt;&quot; button.</td>
</tr>
<tr>
<td>Select files and folders.</td>
<td>4</td>
<td>The &quot;WinCC Web Publishing Wizard – Select Files and Folder&quot; dialog opens. Deactivate the check box &quot;Server Prefix&quot; for local pictures (@....pdl) of the OS client. When the &quot;Server Prefix&quot; check box is not activated, the pull-down selection list below it is grayed out. This means that the local pictures will be published.</td>
</tr>
</tbody>
</table>
|                                  | 5    | Check if the correct path is set in the input field:  
  - **Source path** in the input field "Path to WinCC project folder": enter the path to the directory with the local data of the OS client defined as the OS Web server – this path is entered by default for the local data. An example of a path is provided below in this section under "Example".  
  - **Destination path** in the input field "Publishing folder of the WinCC Web": the path to the "Web Navigator" directory on the OS client defined as the OS Web server. This is the location of the pictures which the Web client should access. This path is entered by default for local data. An example of a path is provided below in this section under "Example". |
|                                  | 6    | If you wish to change the default settings, click on the "Browse" button for the respective input field and enter the desired path. Click the "Next >" button. |
| Select pictures.                 | 7    | The "WinCC Web Publishing Wizard – Select Pictures" dialog opens. This is where all standard pictures and all project-specific pictures are listed. |
## Configuration of the OS Web Server on the ES

### WinCC Publishing – Wizard Dialog

<table>
<thead>
<tr>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| 8    | Select the pictures you wish to publish:  
- Click "OK" when you have selected all the standard pictures you wish to publish.  
- If you wish to publish a selection of the standard pictures, hold down the "CTRL" key and click on the desired pictures. Then click on the ">" button.  
**Note**  
We basically recommend that you publish all standard pictures.  
Click the "Next >" button. |
| 9    | The "WinCC Web Publishing Wizard – Select Functions" dialog opens.  
The project-specific C scripts that you have saved as projects functions on the OS web server are displayed here exclusively.  
Click on the desired button to select all or individual C scripts.  
**Note**  
Since the only project functions available in the pictures are those that were selected in the most recent publishing process, you should select all required project functions for publishing each time you publish. |
| 10   | If you have written project-specific Visual Basic scripts, also activate the check box "Transfer Visual Basic Scripts" and click on the "Next >" button. |
| 11   | The "WinCC Web Publishing Wizard – Referenced Graphics" dialog opens. This dialog list both the standard and the project-specific graphics that are integrated in the process pictures. |
| 12   | Click on the ">>" button to publish all graphics and then click on the "Next >" button.  
The "WinCC Web Publishing – Finished" dialog opens. |
| 13   | If you have not check the pictures you wish to publish in PdlPad, activate the check box "Check scripts" and click on the "Finish" button.  
The option should be activated when new pictures are published for the first time. |
14 Following the publishing process, confirm the message "The pictures have been successfully transferred to the OS Web server." with the "OK" button.

All transferred pictures are displayed to you. If errors are detected in the scripts during publishing, the affected pictures are labeled with a red cross.

Corrupt pictures are listed in a dialog and marked by a red cross. A summary of all published pictures is presented in the "WinCC Web Publishing Wizard - & Finished" dialog. You can select the pictures marked with a red cross and open them with a double-click to correct them in the "PdlPad" editor. In PdlPad, you can use the "Check Scripts" from the "Edit" menu to run a test. Information about possible errors is displayed in a compiling window along with associated line numbers. Corrections made in PdlPad are lost the next time this picture is published. For this reason it makes sense to perform corrections in the WinCC Editor Graphics Designer and then repeat the publishing process.

15 Once you have corrected all pictures, press the "Finish" button. All local data has now been published. The file name extension for PCS 7 picture files is changed to "*.PD_".

Result

The published local pictures are displayed in the data window of the "Web Navigator" editor.
Example for Step 5 of the Publishing Process

The path information used for the section "Publishing Process, Step 5" is based on the following example. The following figure represents the PCS 7 project structure in the SIMATIC Manager.

Data storage: D:\Projects\my_project
The path information in the "WinCC Web Publishing Wizard" is based on the example in the following figure.

1: source path as absolute path in the input field "Path to the WinCC project folder": D:\Projects\my_project\WinCC\WebServer
This path, for example in UNC notation, appears as: \ES\Projects\my_project\WinCC\WebServer

2: destination path as absolute path in the input field "Folder for Web access to your pictures": D:\Projects\my_project\WinCC\WebNavigator\
### 7.2.6 How to Publish Project-specific Data from OS Servers

**Procedure**

<table>
<thead>
<tr>
<th>WinCC Publishing – Wizard Dialog</th>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Open the OS client you wish to use as the OS Web server in the WinCC Explorer on the ES. In the SIMATIC Manager under: <strong>Project Name &gt; PC Station Name &gt; WinCC Application &gt; OS Web Server Name</strong>.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>In the navigation window, open the context menu of the &quot;Web Navigator&quot; object and select the menu command &quot;Web View Publisher&quot;. The &quot;WinCC Web Publishing Wizard – Introduction&quot; window opens.</td>
</tr>
<tr>
<td>Introduction</td>
<td>3</td>
<td>Click the &quot;Next &gt;&quot; button.</td>
</tr>
<tr>
<td>Select files and folders.</td>
<td>4</td>
<td>Activate the &quot;Server Prefix&quot; control box. This activates the associated pull-down list.</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>In the pull-down list, select the OS server from which the OS Web client should access data. The data access is made through the server prefix that corresponds to the logical OS server name.</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Specify the source and the destination path: An example of a path is provided below in this section under &quot;Example&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Source path in the input field &quot;Path to WinCC project folder&quot;: Click on the &quot;Browse&quot; button and navigate to the path where the pictures of the selected OS server are stored.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Caution</strong> Ensure that the selected server prefix and the specified source path belong to the same PC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Destination path in the input field &quot;Publishing folder of the WinCC Web&quot;: This path is already entered by default. Ensure that the path here matches the path for transferring local data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You should recheck the server prefix after all path information in the pull-down list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click the &quot;Next &gt;&quot; button.</td>
</tr>
<tr>
<td>Select pictures.</td>
<td>7</td>
<td>The &quot;WinCC Web Publishing Wizard – Select Pictures&quot; dialog opens. This is where all standard pictures and all project-specific pictures are listed.</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>Click on the &quot;&gt;&gt;&quot; button to publish all pictures. Click the &quot;Next&quot; button.</td>
</tr>
</tbody>
</table>
### Configuration of the OS Web Server on the ES

<table>
<thead>
<tr>
<th>WinCC Publishing – Wizard Dialog</th>
<th>Task</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select functions.</td>
<td>9</td>
<td>The &quot;WinCC Web Publishing Wizard – Select Functions&quot; dialog opens. The project-specific C scripts that you have saved as projects functions on the OS web server are displayed here exclusively. Click on the desired button to select all or individual C scripts. <strong>Note</strong> Since the only project functions available in the pictures are those that were selected in the most recent publishing process, you should select all required project functions for publishing each time you publish.</td>
</tr>
<tr>
<td>Referenced graphics</td>
<td>10</td>
<td>If you have written project-specific Visual Basic scripts, also activate the check box &quot;Transfer Visual Basic Scripts&quot; and click on the &quot;Next &gt;&quot; button.</td>
</tr>
<tr>
<td>Referenced graphics</td>
<td>11</td>
<td>The &quot;WinCC Web Publishing Wizard – Referenced Graphics&quot; dialog opens. This dialog list both the standard and the project-specific graphics that are integrated in the process pictures.</td>
</tr>
<tr>
<td>Referenced graphics</td>
<td>12</td>
<td>Click on the &quot;&gt;&gt;&quot; button to publish all graphics and then click on the &quot;Next &gt;&quot; button. The &quot;WinCC Web Publishing – Finished&quot; dialog opens.</td>
</tr>
<tr>
<td>Finish</td>
<td>13</td>
<td>If you have not check the pictures you wish to publish in PdlPad, activate the check box &quot;Check scripts&quot; and click on the &quot;Finish&quot; button. The option should be activated when new pictures are published for the first time.</td>
</tr>
<tr>
<td>Finish</td>
<td>14</td>
<td>Following the publishing process, confirm the message &quot;The pictures have been successfully transferred to the OS Web server.&quot; with the &quot;OK&quot; button. All transferred pictures are displayed to you. If errors are detected in the scripts during publishing, the affected pictures are labeled with a red cross. Corrupt pictures are listed in a dialog. A summary of all published pictures is presented in the &quot;WinCC Web Publishing Wizard - &amp; Finished&quot; dialog. You can select the pictures marked with a red cross and open them with a double-click to correct them in the &quot;PdlPad&quot; editor. In PdlPad, you can use the &quot;Check Scripts&quot; from the &quot;Edit&quot; menu to run a test. Information about possible errors is displayed in a compiling window along with associated line numbers. Corrections made in PdlPad are lost the next time this picture is published. For this reason it makes sense to perform corrections in the WinCC Editor Graphics Designer and then repeat the publishing process.</td>
</tr>
<tr>
<td>Finish</td>
<td>15</td>
<td>Once you have corrected all pictures, press the &quot;Finish&quot; button. All project-specific data has now been published. The original picture name is given the server prefix and the file name extension is changed to &quot;.PD_&quot;.</td>
</tr>
<tr>
<td>Finish</td>
<td>16</td>
<td>Repeat steps 2 to 15 for all OS servers which the OS Web client should access.</td>
</tr>
</tbody>
</table>
Result

The published project-specific pictures of the OS servers are displayed in the data window of the "Web Navigator" editor.

Example for Step 6 of the Publishing Process

The path information used for the section "Publishing Process, Step 6" is based on the following example. The following figure represents the PCS 7 project structure in the SIMATIC Manager.

Data storage: D:\Projects\my_project

The path information in the "WinCC Web Publishing Wizard" is based on the example in the following figure.
1: source path as absolute path in the input field "Path to the WinCC project folder":
D:\Projects\my_project\wincproj\OSServer
This path, for example in UNC notation, appears as:
\ES\Projects\my_project\wincproj\OSServer

2: destination path as absolute path in the input field "Folder for Web access to your pictures":
D:\Projects\my_project\wincproj\Webnavigator\
7.3 Setting User Rights

7.3.1 Overview

User rights can also be set for OS Web Client access to the OS system. The settings are made the same way as in the "User Administrator" and are identical to those for standard clients. You only need to additionally set the "Web Navigator" check mark for the Intranet/Internet access.

Before setting the user rights, all data must be first prepared with the Web View Publisher.

7.3.2 How to Set User Rights in the User Administrator

Requirement

The required data has been published with the Web View Publisher.

Procedure

1. Open the WinCC "User Administrator" editor on the ES.
2. Create new users/operators or user groups as required. For further information, refer to the chapter "Setting the User Authorizations" in the Operator Station Configuration Manual.
3. Mark the desired user group or user in the tree.
4. Activate the "Web Navigator" control box. This displays two additional input fields.
5. Click on the "Browse" button in the "Start Picture" input field. This displays the "Open" dialog box and all graphics you have published.
6. Select the file "@screen.pd_". Check if the picture file is located in the path ..\OS Web server\<wincc-project-shared-name>\Web Navigator\pictures. The click the "Open" button.
7. If you wish to set a special language for the user groups or users, click on the "Browse" button next to the "Language" input field.
8. In the "Select Language" dialog, select the desired language for the OS Web client's operator control and monitoring interface and click "OK".
9. Close the User Administrator.
**Caution**

**Note**
For the initial configuration, the start picture must be set in the User Administrator locally on the OS Web server because the reference to the start picture can only be made after the ES is loaded on the OS Web server.
7.4 Deactivating the Graphics Runtime

"Graphics Runtime" is enabled in the startup list as the default setting for an OS client. However, "Graphics Runtime" must be disabled for the OS client to be used as the OS Web server.

Procedure

1. Open the OS client you wish to use as the OS Web server in the WinCC Explorer on the ES. In the SIMATIC Manager under: Project Name > PC Station Name > WinCC Application > OS Web Server Name.
2. Click on the "Computer" component in the left navigation window.
3. Right click on the name displayed in the data window and select the "Properties" command from the context menu.
4. Open the "Startup" tab and deactivate "Graphics Runtime" in the "Start sequence of WinCC runtime" field.
5. Confirm your entries by pressing the "OK" button.

Result

The Graphics Runtime user interface will not be started on the when WinCC Runtime starts on the OS Web server.
7.5 Downloading the OS Client (OS Web Server)

Since the OS Web server is only a selected OS client at first, the download of the OS Web server is the same as that of the OS client. The OS Web client becomes the OS Web server by publishing the data; refer to the "Web View Publisher" section and the "Web Configurator" section for the configuration of the Web page.

---

**Note**

You cannot download changes for published pictures to the OS client (OS Web server).

If you cannot deactivate the OS client (OS Web server) for the complete download, proceed as follows:

Publish the changed pictures a second time. For the destination path, enter the path of the PCS 7 project on the OS Web server.

---

Further Information

Web View Publisher

Web Configurator

*Operator Station Configuration Manual, in the section "Downloading a Project and Configuring Changes > How to Download a Single OS"*
8 Completing the Configuration on the OS Web server

8.1 Checking the Settings

We recommend that you check the following settings after downloading the project from the ES to the OS client (OS Web server):

1. Check the OS Web server in the "User Administrator" editor to ensure that the settings you have configured on the ES configured are in effect. If they are not, make the settings on the OS Web server.

2. Open the "Properties Computer" dialog for the OS Web server in the "Computer" editor and then open the "Startup" tab. Check if the "Graphics Runtime" check box is deactivated in the "Start sequence of WinCC runtime" field. If they are not, make the settings on the OS Web server.
8.2 Web Configurator

8.2.1 Overview

The "Web Configurator" allows you to configure and manage the Internet Information Services (IIS) making available the Web page of the OS Web server. The services are run on the OS Web server after you have downloaded the client project to the OS client (OS Web server).

When Do I Need to Use the Web Configurator?

The Web Configurator is used:

- Usually after each new installation of the OS Web server
- After each project changeover
- After each new installation or update to SIMATIC PCS 7 components

Further Information

Wizard-guided Web Setup: Web Configurator

How to Set the Default Web Page for the OS Web Clients

Setting the Default Web Page for the OS Web Clients

Configuration in the Web Configurator for an Existing Web

8.2.2 Wizard-guided Web Setup: Web Configurator

Application

The Web Configurator provides support for managing and configuring the Microsoft Information Service (IIS). Setup and configuration is required to make the OS Web server available to OS Web clients via Intranet/Internet. This is performed on the OS client which is to be used as the OS Web server.

Setting the Default Web Page

Using the Web Configurator, you can select the default Web page displayed when the OS Web client starts up. With the setting "WebClient.asp", a process picture is displayed in the Internet Explorer when the OS Web client starts up. With the "MainControl.asp" setting, a navigation interface is also displayed on the OS Web client; the interface is later needed to download plug-ins. The default setting is "MainControl.asp".
Further Information

- How to set the default Web page for the OS Web clients
- Setting the Default Web Page for the OS Web Clients

8.2.3 How to Set the Default Web Page for the OS Web Clients

You can specify that the OS Web Navigator start picture should also be the starting Web page or that it should be integrated in an existing Web directory only during the initial configuration in the Web Configurator.

**Note**

If you run the Web Configurator again without a new installation of the OS Web server, the Wizard dialog for adding a default Web page or a virtual directory to an existing activated Web site is no longer displayed.

**Requirements**

- The OS Web server is installed on the OS client.
- The client project has been downloaded from the ES to the OS client (OS Web server).
- You have checked the settings on the OS and the pictures have been published.

**Procedure**

1. Open the client project in the WinCC Explorer and select the "Web Configurator" command in the context menu for the "Web Navigator" component. The "Web Configurator" starts. Click the "Next" button.

2. In the next dialog you can decide whether you wish to create use the OS Web Navigator start picture as a new default Web page or integrate it into an existing Web site.
   - If you wish to use the OS Web Navigator start picture as your default Web page, activate the "Create new standard Web site (stand-alone)" option.
   - If you only wish to integrate the OS Web Navigator start picture in your existing Web site, activate the "Add to an existing Web site (virtual directory)" option.

3. For more information about this procedure in the "Web Configurator", refer to the sections "Setting the Default Web page for the OS Web Client" and "Configuration in the Web Configurator for an Existing Web Site".
Completing the Configuration on the OS Web server

Result
You have created a startup-capable Internet page for the OS Web client on the OS Web server.

Further Information
Setting the Default Web Page for the OS Web Clients
Configuration in the Web Configurator for an Existing Web

8.2.4 Setting the Default Web Page for the OS Web Clients

The following settings can be made by selecting the "Create a new standard Web site (stand-alone)" options:

<table>
<thead>
<tr>
<th>Setting Options</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of the web page</td>
<td>You can enter a name for your Web page here, for example: &quot;PCS7Web&quot;.</td>
</tr>
<tr>
<td>Port</td>
<td>Here you can specify a port to be used for accessing the Internet using the &quot;http&quot; protocol. Only numbers in the range 1 to 65535 can be entered. The port numbers up to 1024 are usually set by the system. The standard HTTP port is usually set to 80 in this field.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Select the IP address of the OS Web server through which the OS Web clients should communicate with the OS Web server.</td>
</tr>
</tbody>
</table>
| Selection field for the default Web page | Select here the default Web page to be displayed with the selection of the OS Web server on the OS Web clients in the Internet Explorer.  
  - Selecting "MainControl.asp" enables you to operate and monitor within process pictures. The menu bar also appears in the Internet Explorer of the OS Web clients. Required components for the OS Web clients can be selected and installed from the menu bar.  
  If you wish to hide the menu bar (navigation bar) from users on the OS Web Clients after the plug-ins have been loaded, start the Web Configurator again with the setting "Webclient.asp". To have the menu bar displayed again, a user with administrator rights can call up the start page of the project in the Internet Explorer with the following address information: http://<server name or IP address of the OS Web server>/maincontrol.asp.  
  - Selecting "Webclient.asp" enables you to operate and monitor within process pictures. No menu bar is provided. |
Completing the Configuration on the OS Web server

### Setting Options

<table>
<thead>
<tr>
<th>Setting Options</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconnect Interval</td>
<td>Enter a time interval here for starting an automatic reconnect after a connection is broken on OS Web clients. 0 means the &quot;automatic reconnect&quot; function is disabled.</td>
</tr>
<tr>
<td>Start the Web site after being configured</td>
<td>Activate this check box to automatically open the Web page once configuration is completed. If this option is not enabled, the Web page and the IIS can only be started manually in the Windows management.</td>
</tr>
<tr>
<td>&quot;Finish&quot; button</td>
<td>&quot;Finish&quot; restarts the IIS and activates the newly created Web page (PCS7Web, for example). Confirm the displayed dialog with &quot;OK&quot; button. You can ignore the subsequent message that recommends rebooting the PC.</td>
</tr>
</tbody>
</table>

### 8.2.5 Configuration in the Web Configurator for an Existing Web Site

When the "Add to an existing Web site (virtual directory)" option is enabled, in a dialog box you can select the active Web to which the virtual directory for the OS Web server should be added.

To learn the further steps in the installation, refer to the section "Setting the Default Web Page for the OS Web Clients".

The name of the virtual PCS 7 Web site must be added in addition to the URL (Uniform Resource Locator) for the address information in the Internet Explorer on an OS Web Client to access the OS Web server.

Example: [http://OSWebServer/PCS7Web](http://OSWebServer/PCS7Web).
9 Installations and Settings for the OS Web Client

9.1 Overview

Before you can use the OS Web client for process management, you must perform the following installations and settings on this PC:

- You can make settings in the Internet Explorer or check settings to ensure the installation of the PCS 7 plug-ins.
- The "OS Web Client" application must be installed on the PC on which you wish to use as the OS Web client.
- You have to download the respective required PCS 7 plug-ins from the OS Web server.

To install the OS Web client and the plug-ins, you need at least power user rights on the OS Web client unless the software is installed based on group policy for software distribution in networks.

Further Information

- How to make the settings in the Internet Explorer
- How to Install the OS Web Client on Your PC
- How to Install Plug-ins
- How to Start Process Management on the OS Web Client
9.2 How to Make the Settings in the Internet Explorer

You need to make the following settings in the Internet Explorer or check them to be able to later install the plug-ins for the OS Web client from the OS Web server.

Requirement

The Internet Explorer is installed.

Procedure

1. Open the Internet Explorer.
2. Select the menu command "Options" > "Internet Options" and open the "Security" tab.
3. Depending on how you communicate with the OS Web server, select the "Internet" or "Local Intranet" Web content zone and then click on the "Custom Level" button.
4. Enable the options "Run ActiveX controls marked safe for scripting" and "Download signed ActiveX controls" if these are not already selected.
5. Close the "Security Settings" dialog window with the "OK" button.
6. Select the "Trusted Sites" icon and open the "Trusted Sites" dialog by clicking on the "Sites" button.
7. Enter the address of the OS Web server in the field "Add this Web site to the zone". Examples for formats and wildcards are "http://157.54.100 - 200", "ftp://157.54.23.41", or "http://*.microsoft.com".
8. Disable the check box "Require server verification (https:) for all sites in this zone". Click on the "Add" button. Confirm your entry with "OK".
9. Select the "Trusted Sites" icon. Click on the "Standard Level" button and then on the "Custom Level" button.
10. In the "Security Settings" dialog, select the "Enable" option under "Initialize and script ActiveX controls not marked as safe". Confirm your entry with "OK".
11. Close the "Internet Options" dialog with "OK" button.

Result

You have now fulfilled the requirements for connect to the OS Web server from the OS Web client.
9.3 How to Install the OS Web Client on Your PC

The "OS Web Client" application can be installed on a PC in two different ways:

1. By connecting to the OS Web server and downloading the corresponding installation file over the Intranet/Internet. This corresponds to a "Remote Installation".

2. Using the Windows Installer Package with the name "WinCCWebnavigatorClient.msi" in the following directory on the SIMATIC PCS 7 – DVD:
   Additional_Products > WebNavigator_V6.1 > Setup > Client > Setup
   This corresponds to a local installation.
   The local installation using the Installer Package corresponds to the procedural steps 6 to 11 for "Remote Installation" described below.

Remote Installation

The OS must be open on the OS Web server for the remote installation of the "OS Web Client" application on your PC. The process mode of the OS on the OS Web server first has to be activated for displaying the process pictures.

The following section describes the "remote installation".

Requirements

- The client project has been downloaded to the OS client (OS Web server) and the corresponding OS (WinCC Explorer) is open.
- Access to the OS Web server from the PC which you are using as the OS Web client.
- You know the name or the IP address of the OS Web server.
- You know the domain, user name and corresponding ID.
- You have user permission in the User Administrator for the Web options on the OS Web server.
- You need to be logged on with at least a power user rights on the PC.
**Procedure**

1. Start the Internet Explorer.
2. Connect to the OS Web server by entering the server name or IP address of the OS Web server in the "Address" input field. Use the following syntax: http://<server name> or http://IP address.
3. In the "Enter Network Password" dialog that is displayed enter your user name (WinCC user name that was previously specified for using the Web Navigator) and the your password. If you wish to save your password, activate the check box "Save this password in password list".
4. The "Security Warning" dialog is displayed at the first attempt to connect to the OS Web server. Click on the "Yes" button. This indicates your trust of the content to be installed and scripted.
5. The home page of the OS Web server is now displayed in the Internet Explorer. It consists of two areas. The navigation bar is on the left and the main window appears on the right. Click on the link "Click here to install" in the main window. This starts the installation wizard that will guide you through the installation of the OS Web client application on your PC.
6. Click on the "Open" button in the "File Download" dialog to start the installation wizard.
7. Follow the instructions in the Installation Wizard until the "Customer Information" dialog is displayed. Enter your user name and the name of your company here. Then enable one of the two options for the installation:
   - If you wish to permit any user who can logged on to this PC to use the "OS Web Client" application, enable the option "Anyone who uses this computer". This is the default setting.
   - If you wish to ensure that only the user currently logged on to the PC can use the "OS Web Client" application, enable the option "Only for me".
   - Click on the "Next" button to go to the next dialog of the wizard.
8. Select the type of installation you desire. You can choose between "Complete" or "Custom".
   - Enable the "Complete" option to install all required components. We recommend a complete installation.
   - Enable the "Custom" option to be able to decide yourself which individual components are to be installed.
9. Now follow the instructions of the Wizard.
10. Click on the "Install" button to begin the installation.
11. Click on the "Finish" button to complete the installation.

**Result**

Upon completion of the OS Web client application installation, a dialog is displayed in the Internet Explorer listing all installed components and their size, and version information. Do not click on the "Process pictures" link at this time, first install the PCS 7 plug-ins.
9.4 How to Install Plug-ins

To be able to operate and monitor faceplates in process pictures on the OS Web client, you need PCS 7 plug-ins that allow the faceplates to be operated via the Internet.
Plug-ins are executable programs that are installed for shared use of the Internet connection.

Requirements

- The OS Web client must be installed on your PC.
- The Internet Explorer must be started and displaying the home page of the OS Web server or the result page following the installation of the OS Web client software.

Procedure

1. Open the navigation bar in the Internet Explorer by moving the mouse to the left edge of the window. This opens the navigation bar and displays the main menu.
2. Click on the "double arrow" icon to open the main menu containing the name or IP address of your OS Web server. The submenus are displayed.
3. Open the menus in the download area by clicking on the "Download Area" submenu.
4. Click on "Download plug-ins" in the download area. All available plug-ins for the OS Web client are displayed in the right section of the Internet Explorer. The size, status and a button for their installation are also offered.
5. The following three PCS 7 plug-ins must always be installed:
   - WinCC Basic Process Control
   - WinCC Advanced Process Control
PCS 7 Faceplates

Note: The installation of the "WinCC Basic Process Control" plug-in is a prerequisite for the installation of the "WinCC Advanced Process Control" plug-in.

Under "Install", click on the arrow with the specified version to install these plug-ins one after the other. Installing these plug-ins provides you with the basic functions for operator control and monitoring without SIMATIC BATCH and SFC.

Installing the following four plug-ins provides you with additional operator control functions for SIMATIC BATCH and SFC Visualization if they are available.

- SIMATIC BATCH WinCC Options
- SIMATIC ES Common Services
- SIMATIC SFC Common Displays
- SIMATIC SFC Visualization

Under "Install", click on the arrow with the specified version to install these plug-ins one after the other.

Result

The installation of the OS Web client is now complete. Close the Internet Explorer and open it again in order to log on to the OS Web server in process mode. As soon as process mode (runtime) is activated on the OS Web server, you can call up the process pictures on the OS Web client.
9.5 How to Start Process Management on the OS Web Client

Once you have installed all of the required plug-ins on your OS Web client, you can begin process management.

Requirement

- The OS on the OS Web server has been started in process mode (runtime).

Procedure

- Connect to the OS Web server by entering the server name or IP address of the OS Web server in the "Address" input field. Use the following syntax: http://<server name> or http://IP address.

Result

The start picture offered in the User Administrator on the OS Web server is displayed in the Internet Explorer. The navigation bar is minimized to maximize the display area of the start picture.
9.6 How to Set the Language for the Navigation Bar on the OS Web Client

You can set the language for the OS Web client's navigation bar in the Internet Explorer as follows.

Requirement

The OS on the OS Web server has been started in process mode (runtime).

Procedure

1. Open the navigation bar.
2. Select the "Language" menu and open the submenu.
3. Click on the national flag representing the desired language.

Result

The language of the navigation bar is now set to the desired language.
9.7 Removal and Retro-installation / Updates Including Plug-ins on the OS Web Client

The OS Web client and its plug-ins can only be removed with the function **Start > Settings > Control Panel > Add/Remove Software**.

Retro-installation and updates are performed similar to an initial installation:

- Following logon on the OS Web server, the versions of all installed OS Web client components are compared to those on the OS Web server in the Internet Explorer. If a new version is found on the OS Web server, an update for the OS Web client is offered.
- New plug-ins can be loaded at any time from the Web download menu in the Internet Explorer.
9.8 Functions of the OS Web Client in Process Mode

9.8.1 Overview

The default layout configured on the OS Web server is always used and displayed on an OS Web client. The process pictures displayed on the OS Web client can be operated and monitored as they are on an OS client if the current operator has the appropriate authorization.

The design of the operating interface of the OS Web client is identical to the one on the OS client. It consists of overview, work and key areas. The operating interface, however, is displayed in the Internet Explorer. Button sets 1 and 2 do not include all the functions available on an OS client.

9.8.2 Supported Functions

The PCS 7 Web client offers the following functions for process mode:

In the overview area:

- Selection of process pictures from the Picture Tree Navigator
- "Loop in Alarm" function can only be executed from group displays
- "Print screen" function

Note

If the status line and the selector button area in the overview area are not correctly displayed in the start picture of process management at the first connection, update your Internet Explorer with the command View > Refresh.

If an OS server fails during operation, you will see a change in the working area if the process image of the affected OS server is displayed there (unavailable operator buttons and object representation). Use the command View > Refresh in Internet Explorer to update the corresponding selector button area with the display "<Server down>".

If you click on the selector button area and no picture change occurs in the work area, perform View > Update in Internet Explorer. This ensures, that the current data can be requested and displayed by the OS Web Server.
In the button sets:

Functions for the message system and navigation functions are available in the button sets. The navigation functions for movement in the picture tree are always displayed and are not grayed out even when a process picture cannot be selected.

In the work area / process picture area:

- Operation and monitoring using all PCS 7 faceplates, standard objects, smart objects and Windows objects that can be configured on the PCS 7 OS.
- The functionality for SFC block symbols and SFC faceplates must be implemented before SFC visualization is possible on the OS Web client. The "Section" button which is used for displaying a section is disabled when this functionality is not implemented.
- SIMATIC BATCH faceplates can be used except for the "BATCH Control Center" button.
- An orientation in which plant area you are, is only indirectly possible via the process display shown in the working area.
- If an active SFC instance is opened on an OS Web client, the "Prepared Values" view is displayed on the OS client and not the usual "Current Values" view. Select the desired view from the drop-down list.

Maintenance Station

**Note**
Automatically generated diagnostics and maintenance pictures have not been released for operation.

Further Information

Supported Functions "BPC" und "APC"
Supported Functions "SIMATIC BATCH WinCC Options"
Online Help Web Navigator Information System, Appendices C and D
10 Status Information

10.1 Status Information about the OS Web Server and OS Web Clients

You can call up status information about the OS Web server and OS Web clients from an OS Web server or from any OS Web client. The call is made in the Internet Explorer. The name of the status page is "status.html". The status information shows you which users can access the OS Web server from specific OS Web clients.

The status information is displayed in blocks within the HTML page. An information block is provided for the OS Web server and each connection OS Web client is shown in a separate block.

The following information is displayed:

- The software version of the installed OS Web server
- The number of OS Web clients that can access the OS Web server
- Users with their respective logon and information about the OS Web client where they are logged on

The information is only displayed in English. You must be configured as a user in the WinCC User Administration to be able to open the status page.

Additional Information

How to Display Status Information
10.2 How to Display Status Information

Requirements

- User is configured in the User Administrator.
- The "status.html" age is called from a configured OS Web server or any OS Web Client.

Procedure

1. Open the Internet Explorer on an OS Web server or OS Web Client
2. Enter the following in the "Address" field:
   http://<server name or IP address of the OS Web server>/status.html.
3. Enter your logon name and password.

Result

The status information is displayed on the Web page.
A Appendix

A.1 Supported Functions "BPC" und "APC"

The following table lists the functions that are supported by the PCS 7 OS Web Option in SIMATIC PCS 7 V6.1 when you have installed the following plug-ins on the OS Web client:

- WinCC Basic Process Control (BPC)
- WinCC Advanced Process Control (APC)

Note
The installation of the "WinCC Basic Process Control" plug-in is a prerequisite for the installation of the "WinCC Advanced Process Control" plug-in.

The list of supported functions shows you how to configure your client project on the ES in order for it run as a Web project on the OS Web client. If you only use the functions listed in the table, the "Web View Publisher" will report no errors when you publish pictures and the functions you employ will be supported on the OS Web client. If you only use a function labeled as a "dummy", the "Web View Publisher" will not report errors but these functions will not be supported on the OS Web client.

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions in SIMATIC PCS 7 V6.1</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GetCSigPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>2</td>
<td>GetSignificantMask</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>3</td>
<td>PASSCheckAreaLevelPermission</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>4</td>
<td>PASSCheckAreaPermission</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>5</td>
<td>PASSCheckLevelPermission</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>6</td>
<td>PASSLoginDialog (dummy)</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>7</td>
<td>SFCOpen (dummy)</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>8</td>
<td>LockAreaMessages</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>9</td>
<td>void GetServerTagPrefix(char** ppszServerPrefix, char** ppszTagPrefix);</td>
<td>WebNavigator Basic</td>
</tr>
</tbody>
</table>

WebNavigator Basic

Split Screen Manager standard functions:
<table>
<thead>
<tr>
<th>No.</th>
<th>Functions in SIMATIC PCS 7 V6.1</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>AcknowledgeAllPicture (dummy)</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>11</td>
<td>ALGAcxAddPermissionFilter</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>12</td>
<td>ALGAcxAddPermissionFilterShow</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>13</td>
<td>PTN_CSIG_Ldown</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>14</td>
<td>PTN_CSIG_RDOWN</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>15</td>
<td>PTN_CSIG_RUP</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>16</td>
<td>PTN_NODE_LDOWN</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>17</td>
<td>PTN_NODE_RDOWN</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>18</td>
<td>PTN_OpenPath</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>19</td>
<td>PTN_PICT_CHANGE</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>20</td>
<td>PTN_PICT_LDOWN</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>21</td>
<td>RemovePrefix</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>22</td>
<td>SSMChangeButtonField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>23</td>
<td>SSMChangeOverviewField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>24</td>
<td>SSMChangeWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>25</td>
<td>SSMCheckAreaLevelPermission</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>26</td>
<td>SSMCheckWorkFieldDown</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>27</td>
<td>SSMCheckWorkFieldLeft</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>28</td>
<td>SSMCheckWorkFieldRight</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>29</td>
<td>SSMCheckWorkFieldUp</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>30</td>
<td>SSMChgWorkFieldDown</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>31</td>
<td>SSMChgWorkFieldLeft</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>32</td>
<td>SSMChgWorkFieldRight</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>33</td>
<td>SSMChgWorkFieldUp</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>34</td>
<td>SSMGetAreaFromIndex</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>35</td>
<td>SSMGetAreaFromPath</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>36</td>
<td>SSMGetAreaFromWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>37</td>
<td>SSMGetButtonColor</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>38</td>
<td>SSMGetContainer</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>39</td>
<td>SSMGetContainerToPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>40</td>
<td>SSMGetContPict</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>41</td>
<td>SSMGetIndexFromObject</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>42</td>
<td>SSMGetIndexObjectName</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>43</td>
<td>SSMGetRegistryString</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>44</td>
<td>SSMGetRootToPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>45</td>
<td>SSMGetSAPictureNameEx</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>46</td>
<td>SSMGetScreen</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>47</td>
<td>SSMGetWorkFieldCoordinates</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>48</td>
<td>SSMGetWorkFieldPath</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>49</td>
<td>SSMGetWorkFieldPath</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>50</td>
<td>SSMGetWorkFieldPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>51</td>
<td>SSMHardCopy</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>52</td>
<td>SSMIsUserNameEnable</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>53</td>
<td>SSMIsVariableValid</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>
## Functions in SIMATIC PCS 7 V6.1

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions in SIMATIC PCS 7 V6.1</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>54</td>
<td>SSMLinkCSIG</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>55</td>
<td>SSMOpenSpecField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>56</td>
<td>SSMOpenTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>57</td>
<td>SSMOpenTopFieldFixedSize</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>58</td>
<td>SSMSetAreaNameToPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>59</td>
<td>SSMShowAreaButtonEx</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>60</td>
<td>SSMShowTreeEx</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>61</td>
<td>SSMProgramStart</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>62</td>
<td>SSMProgramExecute</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>63</td>
<td>SSMGetSAPictureName</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>64</td>
<td>GetCountPicture</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>65</td>
<td>SSMPictureStoreSet</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>66</td>
<td>SSMPictureStoreNum</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>67</td>
<td>SSMPictureStoreGet</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>68</td>
<td>SSMPictureMemoryNum</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>69</td>
<td>SSMPictureMemoryRestore</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>70</td>
<td>SSMPictureMemoryInquire</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>

### Functions der SSMAreaStore.dll:

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>71</td>
<td>Init</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>72</td>
<td>SetAreaToWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>73</td>
<td>GetAreaFromWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>74</td>
<td>SetAreaToTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>75</td>
<td>GetAreaFromTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>76</td>
<td>SetStyleToTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>77</td>
<td>GetStyleFromTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>78</td>
<td>SetPictureToTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>79</td>
<td>GetPictureFromTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>80</td>
<td>GetAvailableTopField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>81</td>
<td>SetPictureToWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>82</td>
<td>GetPictureFromWorkField</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>83</td>
<td>GetMaxTopfieldNo</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>

### Functions of ssmrt.dll:

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>84</td>
<td>SSMRTGetAreaFromPicturePath</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>85</td>
<td>SSMRTGetConfigLong</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>86</td>
<td>SSMRTSetConfigLong</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>87</td>
<td>SSMRTGetConfigString</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>88</td>
<td>SSMRTSetConfigString</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>89</td>
<td>SSMRTGetAreaButtonByIndex</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>
### Functions in SIMATIC PCS 7 V6.1

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>SSMRTGetALGFilter</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>91</td>
<td>SSMRTGetALGAdmimFilterLevel</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>92</td>
<td>SSMRTGetALGViewFilterLevel</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>93</td>
<td>SSMRTGetNoAreaEntry</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>94</td>
<td>SSMRTGetAlarmpageConf</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>95</td>
<td>SSMRTGetAvailableTopFieldNo</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>96</td>
<td>SSMRTGetBaseNames</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>97</td>
<td>SSMRTGetWorkFieldCoordinates</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>98</td>
<td>SSMRTGetPicturePathInfo</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>99</td>
<td>SSMRTGetRegistryString</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>

### Functions of ptm_api.dll:

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>PTMRTGetRootNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>101</td>
<td>PTMRTGetParentNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>102</td>
<td>PTMRTGetFirstChildNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>103</td>
<td>PTMRTGetLeftBrotherNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>104</td>
<td>PTMRTGetRightBrotherNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>105</td>
<td>PTMRTGetAreaNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>106</td>
<td>PTMRTGetNode</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>107</td>
<td>PTMRTGetNodeIndex</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>108</td>
<td>PTMRTGetNodeEx</td>
<td>BPC plug-in</td>
</tr>
<tr>
<td>109</td>
<td>PTMRTGetAreaNodeEx</td>
<td>BPC plug-in</td>
</tr>
</tbody>
</table>

### Functions of tagtable.dll:

<table>
<thead>
<tr>
<th>No.</th>
<th>Functions</th>
<th>Plug-in</th>
</tr>
</thead>
<tbody>
<tr>
<td>110</td>
<td>TAGTABLEReadVar</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>111</td>
<td>TAGTABLEReadVarEx</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>112</td>
<td>CSigAPIGetCountPicture</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>113</td>
<td>CSigAPIAcknowledgePicture</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>114</td>
<td>CSigAPIAcknowledgePicture</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>115</td>
<td>CSigAPIGetCountPicture</td>
<td>APC plug-in</td>
</tr>
<tr>
<td>116</td>
<td>CSigAPIGetCountPicture</td>
<td>APC plug-in</td>
</tr>
</tbody>
</table>

### Additional Information

Additional supported functions are listed in the production description of the "Web Navigator Information System" online help, appendices C and D.
A.2 Supported Functions "SIMATIC BATCH WinCC Options"

The supported standard script functions for "SIMATIC BATCH WinCC Options" if you have installed the "SIMATIC BATCH WinCC Options" plug-in are listed below:

- BFOpenPhaseFP
- BFOpenUnitFP
Index

A

ActiveX components ........................................7-2
Additional documentation ..................................1-1
APC ......................................................................A-4

B

BPC.................................................................A-1, A-2, A-3, A-4
Button sets .........................................................9-10

C

C scripts ..........................................................7-3
Checking ..........................................................8-1
Converting ..........................................................7-2

D

Default layout ..................................................9-10
default Web page ..............................................8-3, 8-4, 8-5
default Web pages .............................................8-2
Definition of terms .............................................3-1
Documentation ...................................................1-1, 1-2
Downloading ......................................................7-16, 8-1

E

ES ........................................................................7-1, 7-2, 7-5, 7-9, 7-13
........................................................................7-14, 7-15, 7-16

F

Finishing configuration .......................................8-1
Function overview .............................................3-1
Functions ..........................................................7-2, 9-10, 9-11, A-1

G

Graphics runtime ................................................7-15

H

Hardware requirements ........................................4-1, 4-2

I

IIS .......................................................................8-2

Image window .....................................................7-2
Installation .........................................................9-1, 9-3, 9-4, 9-5, 9-6
OS Web server ....................................................6-1
Internet Explorer ..................................................9-2
Internet options ....................................................9-2
Introduction to configuration ..................................7-1

L

Language setting ................................................9-8
License keys .........................................................5-1
Licenses .............................................................5-1
Loop in Alarm .......................................................9-10

M

MainControl.asp ..................................................8-2
Message line .........................................................9-10
Monitoring ...........................................................9-10

N

Naming convention .............................................7-3
Navigation bar .....................................................9-10
language setting .................................................9-8

O

Operating ...........................................................9-10
Operating interface .............................................9-10
Operator control and monitoring
interface language setting ....................................9-8
OS Web client ......................................................3-1, 9-3, 4-2, 9-1
........................................................................9-2, 9-3, 9-4, 9-5, 9-6, 9-7, 9-9
server licensing ...................................................5-1
OS Web server .....................................................3-1, 3-3, 4-1, 6-1
........................................................................7-16, 8-1, 8-2, 8-3, 8-4, 8-5

P

Path information ..................................................7-8, 7-9, 7-11
PCS 7 OS Web Option .........................................3-1
Picture change ....................................................9-10
Plug-ins .............................................................9-1, 9-5, 9-6
Process management .............................................9-7
Process mode .......................................................9-7
Process pictures ...................................................7-3
Publishing ..........................................................7-3, 7-4, 7-5, 7-6, 7-7
........................................................................7-8, 7-9, 7-10, 7-11
Index

R
Refreshing the view .................................. 9-10
Release Notes
  Important Notes .................................. 2-1
  Removal ......................................... 9-9
  Retro-installation ........................... 9-9

S
Script standard functions .................. A-5
  Security settings .................................. 9-2
  Server down ..................................... 9-10
  Settings ........................................... 9-1
  SFC instances ................................. 9-10
  SIMATIC BATCH .............................. A-5
  Software requirements .................. 4-1, 4-2
  Standard C functions ..................... 7-3
  Standard functions ....................... A-5
  Status information ......................... 10-1, 10-2
  Supported functions ...................... 7-2
  System setup .................................. 6-1

T
Tag names ........................................... 7-3
  TCP/IP connection .......................... 4-1, 4-2

U
Update ............................................ 9-9
  User Administrator ........................ 7-13
  User rights .................................. 7-13

V
  VB scripts ..................................... 7-3

W
  Web Configurator ............................. 7-1, 8-2
  Web server for OS ............................ 6-1
  Web View Publisher .......................... 7-1, 7-2, 7-3
  ........................................... 7-4, 7-5, 7-9
  Web-capable functions ................... 7-2
  WebClient.asp .................................. 8-2